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1- RESÚMEN 

La teledetección, entendida como la técnica de adquisición de datos de la 

superficie terrestre a partir de sensores remotos, ya sea aerotransportados o ubicados en 

plataformas espaciales, supone un gran avance en muchos campos de investigación 

debido a la relevancia de la información que aporta.  

El proceso de adquisición de datos en teledetección consta de diferentes fases: 

captación de datos en bruto, calibración del sensor y conversión de datos brutos a 

radiancia, corrección atmosférica y conversión de datos de radiancia en reflectancia. Por 

último se debe proceder a la validación de los datos, que comprende la comparación de 

los datos de reflectancia obtenidos en campo con los obtenidos en sensores 

aerotransportados. 

ABSTRACT 

Remote sensing, understood as the art data acquisition of the earth's surface from 

remote sensors, whether airborne or located in space platforms, represents a 

breakthrough in many fields of research due to the relevance of the information provided. 

The process of remote sensing data acquisition consists of different phases: 

capturing raw data, sensor calibration and conversion of raw data to radiance, 

atmospheric correction and data conversion reflectance radiance. Finally, proceed to the 

validation data, comprising comparing reflectance data obtained in the field with those 

obtained in airborne sensors. 
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2- INTRODUCCIÓN: 

En el presente trabajo se explica el proceso de validación datos correspondientes a 

imágenes aéreas hiperespectrales, tomadas sobre un viñedo situado en la finca 

experimental de Las Tiesas, en la provincia de Albacete. 

La Teledetección hiperespectral ha demostrado ser una técnica muy poderosa en 

los estudios de la superficie terrestre [1]. Se ha desarrollado como una herramienta 

importante para obtener información de alta resolución espectral y espacial sobre el suelo 

y la vegetación [2][3]. La Teledetección hiperespectral puede ser aplicada  en diversos 

campos como agricultura, la selvicultura y biodiversidad, explotaciones de minerales y 

petróleo, así como en la caracterización del suelo. En concreto, las firmas espectrales de 

banda estrecha son particularmente eficientes en la obtención de información sobre la 

superficie terrestre. 

Una parcela con viñedos como explotación tiene una estructura heterogénea, 

dispuesta en hileras (denominadas lindes), y espacios vacíos de suelo desnudo entre 

hileras, lo que supone una disposición de vegetación irregular. En referencia al tamaño del 

píxel de las imágenes del sensor CASI, podemos afirmar que los píxeles de las imágenes 

siempre contendrán una mezcla de las firmas espectrales de ambas estructuras 

(vegetación y suelo desnudo), por lo que la técnica de muestreo tuvo que ser ideada 

teniendo en cuenta éste aspecto de heterogeneidad del área de estudio. 

Para la caracterización espectral se realizaron mediciones de la viña desde campo 

con un espectro radiómetro, a la misma hora de que se tomaban las imágenes aéreas. 

Dichos espectros  fueron utilizados para comparar los píxeles correspondientes en la 

imagen hiperespectral. 

El paso final es obtener unos estadísticos para cada imagen, ofreciéndonos una 

estimación sobre el grado de correspondencia entre los datos de las medidas de campos y 

los datos hiperespectrales aéreos. 
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3- OBJETIVOS 

3.1- SENSORES AEROTRANSPORTADOS 

3.1.1.- TELEDETECCIÓN AÉREA HIPERESPECTRAL 

La teledetección se define como la obtención de información referida a un objeto, 

a través de instrumentos que se encuentran alejados de dicho objeto de estudio. 

Situándonos en el contexto de éste trabajo, el instrumento es un sensor aerotransportado 

(teledetección aérea), mientras que el objetivo de investigación superficie terrestre. 

Los sensores tienen una serie de características que definen el tipo de aplicaciones 

finales de las imágenes tomadas por dichos sensores. 

-Resolución espacial: se define como el objeto más pequeño que se puede 

identificar en una imagen. Está determinado por el tamaño del pixel de la imagen, medido 

en metros sobre el terreno, aunque también depende de la altura del sensor sobre la 

Tierra, el ángulo de observación, velocidad de escaneado y características ópticas del 

sensor.  

-Resolución temporal: es el tiempo que tarda un sensor en volver a obtener 

imágenes de la misma parte de la superficie terrestre. 

-Resolución espectral: se trata de la capacidad que tiene un sensor para obtener 

datos en diferentes rangos del espectro electromagnético. 

-Resolución radiométrica: se trata del número de niveles digitales de un píxel de la 

imagen, utilizados para expresar los datos recogidos por el sensor. 

En cuanto a la diferencia entre una imagen hiperespectral de una multiespectral es 

la cantidad de bandas que contiene y la continuidad de las mismas. Esto permite definir 

espectros continuos para cada pixel de la imagen, de forma similar a las curvas que podemos 

obtener con un espectro radiómetro de laboratorio, con la diferencia de que en este caso solo 

medimos en un punto, mientras que la imagen nos proporciona una representación 

bidimensional de los espectros. 
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Figura 1: Firma espectral de la vegetación tomada con un sensor multiespectral y un sensor 

hiperespectral [1] 

Observando la Figura 1 se puede apreciar la firma espectral de una cubierta 

vegetal, ofrecida por un sensor multiespectral, como puede ser el Landsat-TM, que cuenta 

con 7 bandas. En el caso de un sensor con la capacidad de adquirir imágenes 

hiperespectrales, el espectro estaría mucho más definido y tendría mayor detalle que la de 

un sensor multiespectral. Ésta característica permite profundizar en el estudio de 

numerosas propiedades fisiológicas y estructurales de la vegetación debido a la capacidad 

de detectar señales de absorción/reflexión que producen muchos de los componentes 

bioquímicos y biofísicos de las plantas a lo largo de longitudes de onda espectral acotadas. 

Esto permite profundizar en el estudio de numerosas propiedades fisiológicas y 

estructurales de la vegetación, debido a su capacidad de detectar las señales de 

absorción/reflexión que producen muchos de los componentes bioquímicos y biofísicos de 

las plantas a lo largo de longitudes de onda espectral acotadas. [2] 

En el presente trabajo se trabajará con imágenes hiperespectrales. 
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3.1.2.- SENSOR CASI    

El sensor CASI (Compact Airborne Spectrographic Imager) (Figura 2), se trata de un 

sensor de adquisición de imágenes por empuje (pushbroom), basado en un CCD 

bidimensional que mide la energía incidente a lo largo de 1500 píxeles "across-track". 

Consta de un total máximo de 288 bandas espectrales, pero puede ser programado para 

adquirir imágenes de 144 o 288 bandas espectrales, dependiendo la altitud de vuelo (1000 

m. -> 288 bandas ó 1859 m. -> 144 bandas espectrales) [3] 

Fue desarrollado por la casa Imagine Group ArgonST, bajo los requerimientos 

específicos del INTA (Instituto Nacional de Técnica Aeroespacial) [3] [4]  

 

Figura 2: Sensor CASI y avión INTA [3] 

 

Características radiométricas y espectrales 

El sensor CASI tiene una resolución radiométrica de 14 bits, y una resolución 

espectral máxima de 288 bandas espectrales (programable también a 144 canales), 

sensible a las longitudes de onda comprendidas entre los 365 y 1050 nm. (ultravioleta, 

parte visible del espectro electromagnético  e infrarrojo cercano) [4]. Configuración 

espectral sensor CASI: 
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CANAL 
LIMITES ESPECTRALES ZONA DEL ESPECTRO 

ELECTROMAGNÉTICO Inferior (nm.) Superior (nm.) 

B1  -  B7 363.9 378.4 ULTRAVIOLETA 

B8  -  B36 380.9 448.5 VIOLETA 

B37  -  B55 450.9 494.2 AZUL 

B56  -  B86 496.6 568.9 VERDE 

B87  -  B95 570.9 590.1 AMARILLO 

B96  -  B107 592.5 618.8 NARANJA 

B108  -  B162 621.2 750.2 ROJO 

B163  -  B288 752.6 1052.6 INFRARROJO CERCANO (NIR) 

 Tabla 1: Configuración espectral sensor CASI 

 

Geometría de la adquisición 

Conocer la geometría de la adquisición de los sensores de observación de la Tierra 

es una tarea fundamental para poder utilizar posteriormente poder utilizar los datos 

obtenidos en éstas imágenes.  

En el caso del sensor CASI (Figura 2), siendo un sensor lineal CCD tipo pushbroom, 

las imágenes obtenidas se caracterizan por el FOV (Field of View o ángulo de campo 

recogido por el sensor completo) y el IFOV (Instantaneous Field of View o ángulo de campo 

instantáneo, que es el ángulo que corresponde a un solo pixel del sensor, medido en 

mrad) (Figura 3) y el ancho y velocidad de barrido (swath, medida de la cobertura lineal del 

sensor sobre el terreno, en metros, especifican su orientación interna y la cobertura y 

resoluciones espaciales a las que puede registrar un dato [1]. 
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Figura 3: FOV e IFOV [1] 

. 

Sensor CASI 1500 

Tipo Pushbroom 

FOV 40o 

IFOV 0.5 mrad 

Altitud sobre el terreno (m.) 1000 m. / 1859 m. 

Tamaño píxel sobre terreno: GSD (m.) 2m. / 1.25 m. 

Anchura de barrico (swath) 1.500 píxeles "across-track" 

Tabla 2: Características geométricas del sensor CASI. [5] 

 

Integración con un sistema inercial de posicionamiento y orientación 

Anteriormente se ha afirmado que debemos obtener la orientación del sensor para 

poder utilizar sus datos. En este tipo de sensores se consigue llevando a cabo una 

orientación directa que requiere disponer de los datos de una unidad de medida inercial 

(IMU) integrada en el sensor, y un GPS (sistema de posicionamiento global). (Figura 4, 

sensor CASI en avión INTA) 
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Figura 4: Sensor CASI  

 

La IMU mide ratios de rotaciones y aceleraciones mediante tres giróscopos de fibra 

óptica y tres acelerómetros de silicio, respectivamente, que permiten obtener una 

precisión en la medida angular en post-proceso de 0.008˚ para el alabeo (roll) y el cabeceo 

(pitch), y 0.015˚ para el azimut (true heading) [6] 

El receptor GPS de doble frecuencia (L1/L2) y 12 canales, capaz de operar en modo 

diferencial, proporciona datos de posición y velocidad de la trayectoria de vuelo con una 

precisión de 5-10 cm en post-proceso [6] 

La integración de un sistema de ésta naturaleza con los sensores de teledetección, 

permite registrar datos de posición geográfica y ángulos de actitud del sensor durante la 

adquisición de imágenes de alta precisión [7] 
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3.2. – ÁREA DE ESTUDIO 

3.2.1. – ZONA DE TRABAJO 

Las medidas de campo utilizadas para éste trabajo y los datos hiperespectrales, 

fueron obtenido durante la campaña REFLEX (Regional Experiments for Land Atmosphere 

Exchanges) en la que participó el tutor del presente trabajo. Dicha campaña se llevó a cabo 

durante el mes de Julio del año 2012, en la finca experimental de Las Tiesas (Figura5), 

municipio de Barrax,  en la provincia de Albacete, y a 22 km. al noroeste de la ciudad de 

Albacete [3]. 

 

Figura 5: Localización Finca de las Tiesas. 
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Figura 6: Viñedo objeto de estudio, enmarcado en polígono rojo. 

 

La ubicación de dicha finca está aproximadamente a 700 msnm. Es una zona donde 

predominan morfologías de las forma plana, como las llanuras. Además los tipos de 

cultivos son bastante uniformes, por lo que es un lugar de ensayo apropiado para 

aplicaciones de Teledetección. Aproximadamente el 65% de la superficie es de secano y el 

35% son de regadío, existiendo en el mismo terreno diferentes cultivos. El clima es de tipo 

Mediterráneo, con una precipitación media anual por debajo de los 400 mm., que se 

concentran principalmente en otoño y primavera [3]. 

El viñedo de la zona de estudio tiene una superficie aproximada de 6,8 hectáreas. 

Las mediciones de campo fueron restringidas a un área de 2,4 hectáreas en la parte norte 

de la viña, que tiene como cultivos el mismo tipo de vid (Vitis vinífera). Las vides tienen 

una altura aproximada de 1,3 m., y se ubican en filas orientadas al NW-SE, con una 

distancia entre lindes de alrededor de 3 metros (para facilitar el acceso de maquinaria). Las 

áreas de suelo que se encuentran entre linde y linde se componen de suelo desnudo, 

aunque con un poco de recubrimiento por el crecimiento de algunas malas hierbas [3]. 

Para las medidas de campo dentro del viñedo, se seleccionaron al azar tres 

parcelas o plots de aproximadamente 3m. x 6m. Cada una de dichas parcelas está 
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compuesta por 3 transectos. Dichos transectos están separados por un metro de distancia 

y tienen una longitud de 6 metros, de tal manera que el punto de inicio y final de cada 

transecto se ubicaría en el centro entre dos hileras de vides. Un transecto de 6 metros se 

puede considerar como la unidad más pequeña y homogénea de medición en éste tipo de 

cultivo, de tal manera que si el transecto fuera desplazado dentro de la viña, siempre 

cubriría dos hileras de vides y dos áreas entre filas de vides (donde no hay viñedo, 

denominado suelo desnudo) [3] 

 

 

Figura 7: Distribución de Plots en el viñedo objeto de estudio.  
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3.2.2. – VUELOS  

En los vuelos realizados durante la campaña REFLEX, se tomaron datos con dos 

sensores; AHS (S / N 001, Argon ST, Fairfax, VA, EE.UU.) y CASI-1500 (ITRES Investigación 

Limited, Calgary, AB, Canadá). Pero en el caso del presente trabajo sólo se tratarán los 

datos correspondientes al sensor CASI. Ambos sensores AHS y CASI del INTA estaban 

montados en el CASA 212 a 200 N / S 270 avión "Paternina". Debido a que el objetivo 

general de la campaña apuntaba principalmente a las adquisiciones por parte del AHS, las 

configuraciones fueron diseñadas de tal manera que si se producían contradicciones entre 

AHS y CASI, se diese preferencia al AHS. Además las líneas de vuelo se colocaron para 

cubrir de forma óptima el lugar de calibración de pastizales, que estaba justo al lado de la 

viña [3]. 

Los datos fueron adquiridos en 2 alturas diferentes, ya sea con AHS como el sensor 

"maestro" (MSL5600FT) y CASI como "esclavo", o con el CASI como "maestro" 

(MLF9000FT) y AHS como "esclavo". Se realizaron dos líneas de vuelo a MSL5600FT (Figura 

8) [3] y 5 líneas de vuelo a MSL9000FT, las líneas fueron diseñadas para cubrir múltiples 

ángulos de visión, de tal manera que se solaparan [3] (Figura 8). 

   

Figura 7: Líneas de vuelo [3]. 

Las ubicaciones exactas de las líneas de vuelo se dan en la Tabla 3. Las coordenadas 

del punto inicial y final de las líneas de vuelo se muestran, según el sistema 

WGS84/ETRS89. La altitud se da en pies sobre el nivel medio del mar. 

La adquisición y procesamiento de datos fue realizado por el personal de INTA. 
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Línea/Dirección 
vuelo 

Latitud Longitud Altitud (ft) 

P01W N39 3.929'  W002 7.429' 5600/9000 

P01E N39 2.980' W002 3.450' 5600/9000 

P02W N39 3.599' W002 7.429' 9000 

P02E N39 3.599' W002 3.450' 9000 

P03W N39 3.270' W002 7.429' 9000 

P03E N39 2.322' W002 3.450' 9000 

P11N N39 4.882' W002 5.774' 5600/9000 

P11S N39 1.661'  W002 6.281' 5600/9000 

P21N N39 4.836' W002 5.496' 9000 

P21S N39 1.733' W002 6.713 9000 

P22N N39 4.549' W002 4.210' 9000 

P22S N39 1.446' W002 5.427 9000 

Tabla 3: Líneas y alturas de los vuelos 

 

Primer día de vuelo (25/06/2012): 

El primer vuelo fue el Miércoles, 25 de julio 2012. Las condiciones meteorológicas 

fueron algunas nubes altas y viento del sur con intensidad variable. La adquisición de datos 

se inició a las 08:41 UTC. Se formaron dos líneas sobre el campo de prueba a una altura de 

MSL5600FT, comenzando con P11 desde el sur hasta el final. Más tarde, el avión se volvió 

hacia el Oeste para volar P01 con 107 ° de rumbo verdadero [3].  

El avión subió a MSL9000FT y fueron cubiertas cinco líneas más, primero P01, esta 

vez desde el este hasta el final, rumbo verdadero 287 °, luego P02 con rumbo opuesto, y 

P03 con 287 °. Después, P03 se repitió con rumbo opuesto (107 °) debido a las dificultades 

para seguir la línea nominal debido al viento cruzado [3].  

A continuación en avión giró a la izquierda, con el fin de llevar a cabo P22 del Norte 

a Sur con 197 ° rumbo verdadero, y para terminar, P21 se realiza siguiendo un rumbo de 

017 °. De adquisición de datos se completó a las 09:47 UTC [3]. 
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Segundo día de vuelo (26/06/2012): 

El segundo vuelo tuvo lugar el Jueves, 26 de julio 2012. Las condiciones 

meteorológicas eran cielos despejados con viento del sureste. La adquisición de datos se 

inició a las 08:42 UTC [3].  

Se tomaron dos líneas de vuelo a MSL5600FT primero P11 fue tomado desde el sur 

hasta el final. Más tarde, el avión se dirigió a la izquierda para volar P01 con 107 ° rumbo 

verdadero [3].  

A continuación el avión subió hasta MSL9000FT para completar otras tres líneas de 

vuelo: en primer lugar, P01 con un rumbo verdadero de 287 °, P21 con 017 ° y P22 con 197 

° .La adquisición de datos se completó a las 09:38 UTC (11:38 CEST) [3]. 

3.2.3. – IMÁGENES: 

Las imágenes con las que trabajamos fueron corregidas atmosféricamente 

utilizando el módulo de corrección atmosférica ATCOR 4. Mediante éste proceso  se 

obtienen imágenes con valores de reflectancia. La corrección atmosférica fue llevada a 

cabo por personal del INTA. 

 
Figura 7: Ejemplo de nombre de imagen. 

 

Nomenclatura de las imágenes (Figura 7 y Tabla 4) [4]: 

CAS: Sensor (CASI) 

120725: fecha de la toma (25 de Julio de 2012) 

0843Z: hora de adquisición (8:43 UTC) 

P11: línea de vuelo (pasada de vuelo) 

SF: Spectral Full Resolution, máxima resolución espectral. En el caso de las imágenes 

denominadas en éste apartado como SF, tienen 288 bandas espectrales. En caso de 

nombrarse como E2, contienen 144 bandas espectrales. 

L: grado de procesamiento de las imágenes (Level) 
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1b: calculada radiancia. 

bsq: extension del archivo. 

Field Content # Charact Example 

Sensor 
Sensor acquiring 
the image. Fixed 

field: CASI 
3 CAS CASI 

Acquisition date 

acquisition date 
as 
YearMonthDay: 
yymmdd 

6 90522 May 22nd, 2009 

Time Z 

Time of 
acquisition, UTC 
(hhmm) followed 
by a Z to flag the 
field: hhmmZ 

5 1045Z 10:45 UTC 

Flight Line  

Flight line 
identification, 
usually following 
the flight report. 
Fixed character 
“P” + line 
identification 
(XX): PXX 

3 P01 Flight Line 01 

CASI image 

mode: MM 

1 E3 
Spectral 96 

bands 

E: Spectral 

E1: spectral, row 

sum 1 (288 

bands) 

E2: spectral, row 

sum 2 (144 

bands) 

E3: spectral, row 

sum 3 (96 bands) 

... 

E9: spectral, row 

sum 9 

EA: spectral, row 

sum 10 

EB: spectral, row 

sum 11 

EC: spectral, row 

sum 12  (24 

bands) 

SF: Spatial Full 

resolution 

SX: Spatial with 

specific band set 

Processing level 

Flag for 
processing level. 
Fixed field: L 

1 L Level 

1a: raw data 2 1c 

At-sensor 
georeferenced 

radiance  
nw/(cm2 sr 

nm) 
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1b: calibrated at-
sensor radiance 

(= SRU/1000) 

1c: L1b 
georeferenced   

2b: reflectance   
2c: L2b 
georeferenced   

Spectral range 

 Not specified: all 
bands acquired 

3 RGB   

RGB: 4-bands 
subset for true or 
false colour 
combinations 

SUB: any other 
subset 

DCU: all bands 
but including dark 
current and 
uniformity frames 

Tabla 4: Nomenclatura de las imágenes [4]. 

 

SENSOR 
FECHA 
VUELO 

HORA 
ADQUISICIÓN 

ALTITUD SOBRE EL 
TERRENO (m.) 

TAMAÑO DE 
PÍXEL (m) 

BANDAS 
ESPECTRALES 

CASI 25/07/2012 8:43 1000 2 288 

CASI 25/07/2012 8:51 1000 2 288 

CASI  25/07/2012 9:02 1859 1.25 144 

CASI 25/07/2012 9:11 1859 1.25 144 

CASI 25/07/2012 9:19 1859 1.25 144 

CASI 25/07/2012 9:28 1859 1.25 144 

CASI 25/07/2012 9:38 1859 1.25 144 

CASI 25/07/2012 9:46 1859 1.25 144 

CASI 26/07/2012 8:44 1000 2 288 

CASI 26/07/2012 8:53 1000 2 288 

CASI 26/07/2012 9:09 1859 1.25 144 

CASI 26/07/2012 9:19 1859 1.25 144 

CASI 26/07/2012 9:27 1859 1.25 144 

CASI 26/07/2012 9:40 1859 1.25 144 

Tabla 5: Datos de imágenes captadas. 
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En éste proyecto, dependiendo de la altitud de vuelo en la captación de cada 

imagen, se trabajará con 288 bandas o con 144 (imágenes a 1000 m. de altitud: 144 

bandas. Imágenes a 1859 m. de altitud: 288 bandas espectrales) También es reseñable que 

sólo se trabajará con diez imágenes, correspondientes a las horas 8:43, 8:51, 9:02, 9:11 y 

9:46 del día 25 de julio de 2012, y las horas 8:44, 8:53, 9:09, 9:19 y 9:40 del día 26 de julio 

de 2012, ya que son aquellas imágenes donde se visualiza la viña correspondiente a la 

zona de estudio. 
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3.3. – DATOS DE CAMPO 

3.3.1. – MEDIDAS DE CAMPO 

Para la obtención de las medidas de campo fueron empleados dos 

espectroradiómetros GER1500 (Spectra Vista Corporación, Poughkeepsie, NY, USA) 

operando en el modo Bi-cónico de doble haz, utilizando un portátil equipado con el 

software DFOV 1500. En el modo de doble haz, uno de los espectroradiómetros se empleó 

como sensor de objetivo, mientras que el segundo dispositivo se usó como sensor de 

referencia. Ambos espectroradiómetros tienen que ser intercalibrados usando mediciones 

simultáneas de paneles de referencia. 

Para las mediciones del objetivo, el sensor de referencia se mantuvo en un punto 

fijo sobre el panel de referencia, con ambos (sensor y el panel de referencia) fijados a 

trípodes. El sensor que mide el objetivo se monta en la parte superior de un poste de 2,8 

m, usando cinta adhesiva. El ángulo entre el poste y el espectrómetro fue ajustado a 

aprox. 25 °, de modo que cuando el poste se inclina tomarse a 2,5 m de altura desde el 

nadir, para que el operador interfiera lo menos posible con el campo de visión del sensor. 

Durante la medición, los ángulos del poste y el sensor se verificaron por un miembro del 

equipo.  

Los espectroradiómetros GER 1500 registran en el rango espectral de 350 a 1050 

nm, con intervalos de 1 nm., y con una resolución espectral de 3,2 nm. Se ha usado un 

ángulo de 8 ° en el elemento óptico delantero, con lo que resulta en un campo de visión de 

35 cm en el suelo a una altura de medición de 2,5 m. la velocidad de Integración se pone 

en automático. Cada muestra representa el promedio de 16 exploraciones. 

Webcam  

Además, para cada espectro medido, fue grabada una foto con una cámara web 

conectada en el ordenador (Figura 10), con el fin de estimar más tarde la cobertura 

fraccional de suelo y la vegetación de la imagen, después de intercalibración de los campos 

de visión de la cámara y el espectrómetro. La cámara web se montó en la parte superior 

del objetivo del espectroradiómetro GER 1500, mirando en la misma dirección que el 

sensor. 
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Figura 8: Sensor de medidas de campo montado sobre un poste, sobre el objetivo. 

 

METODOLOGÍA: Plan de muestreo de campo  

Los espectros de campo se recogieron en 3 parcelas (plots) con 3 transectos 

respectivamente. El plot 1 y el primer transecto del plot 2 fueron muestreados el 25 de 

julio de 2012 en tras 08:00-10:10 UTC; el transecto 2 y 3 del plot 2 y el total del plot 3 se 

tomaron el 26 de julio 2012 entre 8:20 y las 11:20 UTC. Por lo tanto, la adquisición de 

datos de campo y el aire se llevó a cabo de forma simultánea (los plots serán identificaron 

como V1, V2 y V3 a partir de ahora). 

Para capturar una muestra representativa, es decir, una representación imparcial 

de cubiertas fraccionarias de la vegetación y el suelo desnudo dentro de un transecto, los 

espectros se registraron cada 25 cm. En total, se recogieron 236 espectros.  

Las mediciones de intercalibración se llevaron a cabo antes y después de las 

mediciones de cada plot. 

Para la validación de los datos obtenidos por el sensor CASI se utilizarán los valores 

medios de los tres Plots (suma de los tres Plots, dividido entre 3 muestras; Plot Medio) 
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3.3.2. – TRATAMIENTO DE LOS DATOS DE CAMPO 

Las mediciones de radiación tomadas por el espectroradiómetro GER fueron 

convertidas a reflectancia. Los cálculos se realizaron en Excel utilizando el GER 1500 DFOV 

Plantilla de reflectancia (versión 031) proporcionado por NERC 

(http://fsf.nerc.ac.uk/calibration/cal_files.shtml). Una vez completado éste paso, todos los 

espectros fueron remuestreados para que coincida la resolución espectral del sensor CASI. 

Una vez que los datos de ambas fuentes son comparables, se llevaron a cabo diferentes 

técnicas estadísticas para entender algunos de los problemas en el proceso de ampliación 

de la escala de un cultivo heterogéneo como es una viña. Se procede realizando los 

siguientes pasos: 

1) Cálculo de los espectros representativos de vegetación y suelo desnudo para 

cada uno de los plots de estudio: se selecciona en cada plot las 6 medidas de 

campo con el NDVI más alto (Figura 9). Éstas medidas corresponden a píxeles 

que contienen hojas de vid en su totalidad. Se calcula la media y ésta medida se 

toma como representativa de la vegetación para ése plot. Para el cálculo del 

espectro representativo del suelo se calcula la media del resto de espectros de 

campo para ese plot, ignorando las 4 medidas más próximas a cada vid (dos a 

cada lado), ya que pueden estar contaminadas por los píxeles de vid contiguos. 

Debido a que la comprobación de los datos del sensor CASI van a ser 

comparados con los valores de Plot Medio, se debe realizar la media de los tres 

plots para las medidas de suelo desnudo y de vegetación. 

2) Se remuestrean los espectros de vegetación y suelo del Plot Medio para que las 

longitudes de onda coincidan con las del sensor CASI, con el fin de poder 

realizar una comparación estadística entre medidas de campo y medidas del 

sensor CASI. Utilizando el software ENVI, se procede de la siguiente manera: 

 

http://fsf.nerc.ac.uk/calibration/cal_files.shtml
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                  Figura 9: Medidas NDVI. Sensor CASI 

 

Remuestreo de los datos de campo: 

Puesto que los canales de medida del espectroradiómetro GER (a partir de ahora 

denominadas medidas de campo), no coinciden con las del sensor CASI, debemos 

remuestrear las medidas de campo. 

Disponemos de las medidas de reflectancia de campo medidas con el 

espectroradiómetro. Éste  instrumento mide desde 350 nm hasta 1088, a intervalos de 1 

nm. También disponemos de los datos aerotransportados del sensor CASI, que mide desde 

363 nm hasta 1052 nm. A la hora de remuestrear se debe tener en cuenta la anchura de 

los canales del CASI, la cual depende del número de canales, pues dicho sensor puede 

funcionar con 144 o con 288 canales. En el caso de trabajar con 288 canales, la resolución 

espectral es de 2.4 nm, y en el caso de trabajar con 144 canales la resolución espectral es 

de 4.8 nm. 

Una vez se tiene en cuenta lo anterior se comienza a realizar el proceso de 

remuestreo, para que las medidas de campo y las del CASI estén dadas para las mismas 

longitudes de onda y con la misma resolución espectral: 
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1) Lo primero que necesitamos son los espectros de las medidas de campo (GER) de suelo 

desnudo y de vegetación, por separado, construidos con los datos de plot medio (la 

media de los tres plots), con las longitudes de onda (λ) en nm y en formato tipo texto, 

denominados como: 

- GER_soil_V_MEDIO_nm.txt: datos suelo desnudo, Plot Medio 

- GER_veg_V_MEDIO_nm.txt: datos de vegetación, Plot Medio 

2) Es necesario disponer de un fichero tipo texto con las longitudes de onda del CASI en 

una columna y en otra columna contigua, la anchura media altura (FWHM = Full Width 

at Half Maximun, tomada como resolución espectral) de cada banda.  

Para disponer de éste fichero se debe abrir una imagen en ENVI correspondiente a la 

zona de estudio (sin tener en cuenta la información que aporta, ya que lo que 

queremos obtener es un fichero con las longitudes de onda de dicho sensor) A 

continuación, pinchamos con el botón derecho sobre la imagen -> Z Profile (Spectrum): 

 

                          Figura 10: Z Profile (Spectrum) 
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Sobre la nueva ventana emergente aparece un perfil correspondiente al espectro de un 

píxel cualquiera: 

 

Figura 11: Perfil espectral de un píxel cualquiera. 

 

A continuación; File -> Save Plot as-> ASCII. (Se debe realizar el anterior proceso dos veces, 

uno para las imágenes con 144 canales otra para las imágenes de 288 canales) 

En el fichero de salida obtenemos en la primera columna la longitud de onda de cada canal 

del sensor CASI, y en la otra será DN o valor de reflectancia, según el fichero que 

hayamos escogido. Como se dice anteriormente, sólo necesitábamos las longitudes de 

onda de cada canal, por lo que la segunda columna no es necesaria, y procedemos a 

sustituir dichos valores por el valor de FWHM en la segunda columna, según la imagen 

sea de 144 canales (4.8 nm.) o 288 (2.4 nm.) Dichos ficheros han sido denominados 

como: 

     -CASIwavelenghtsFWHM144 

     -CASIwavelenghtsFWHM288 

Y deben tener la siguiente estructura: 
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Figura 12: CASI FWHM imágenes de 288 y 144 canales. 

 

3) El tercer elemento necesario para poder realizar el proceso de remuestreo a través del 

software ENVI, es construir librerías espectrales; una para los espectros de suelo 

desnudo y otra para vegetación. Se procede de la siguiente manera a través del 

software ENVI:  

En la barra de herramientas de ENVI: Spectral -> Spectral Libraries -> Spectral Libraries 

Builder 

Se abre una ventana donde debemos marca: First Input Spectrum -> OK. 

Se abre otra ventana denominada Spectral Library Builder. En ella: 

Import -> From ASCII File -> GER_soil_Vmedio_nm.txt (o GER_veg_Vmedio_nm.txt, ya 

que hay que crear una librería para datos de suelo desnudo y otra para vegetación) 

Se abre Input ASCII File, y en ella: Wavelength units: nanometres -> OK 

Tras pulsar OK, ENVI vuelve a abrir la ventana Spectral Library Builder, y en ella: Plot ->  

File -> Save Plot As -> Spectral Library. Y en la última ventana emergente debemos 

introducir el nombre de salida para la librería: GER_soil_Vmedio_nm. 

Se debe realizar de nuevo ésta operación, para crear una librería para vegetación: 

GER_veg_Vmedio_nm. 

4) Después de realizar los tres pasos anteriores tenemos todo lo necesario para 

resamplear. Se procede de la siguiente manera en ENVI: 

Spectral -> Spectral Library -> Spectral Library Resampling. Se abre la ventana Spectral 

Library Resampling Input File, donde debemos seleccionar la librería de campo que 

queremos remuestrear, por ejemplo GER_soil_Vmedio_nm (se debe hacer con cada 

una de las dos librerías) 
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A continuación, se abre la ventana Spectral Resampling Parameters, y en ella: 

Resample Wavelengths to -> Import ASCII file -> Enter Output Filename: 

GER_soil_Vmedio_nm_resampled_288 o GER_soil_Vmedio_nm_resampled_144, 

dependiendo si se procede a remuestrear a 288 o a 144 canales. 

Posteriormente se abre la ventana Enter File containing Output Wavelenghts. En ella 

seleccionar: CASIwavelenghtsFWHM144.txt o CASIwavelenghtsFWHM288.txt 

(Wavelength: column 1, FWHM: column 2 y Wavelenght Units como nm.) 

Para terminar, es necesario guardar la librería creada con los datos remuestreados 

como un fichero de tipo texto, para posteriormente poder realizar análisis estadísticos 

con dichos datos. Éste paso se realiza de la siguiente manera a través de la barra de 

herramientas de ENVI: 

Spectral -> Spectral Libraries -> Spectral Libraries Viewer 

En la ventana emergente, seleccionamos el archivo con las medidas remuestreadas. A 

continuación: File -> Save Plot As -> ASCII File, y lo guardamos como 

GER_soil_Vmedio_nm_X.txt o GER_veg_Vmedio_nm_X.txt, con X = 144 o 288 según 

remuestreemos 144 o 288 canales. El resultado son 4 ficheros 

(GER_soil_Vmedio_nm_144.txt, GER_soil_Vmedio_nm_288.txt, 

GER_veg_Vmedio_nm_144.txt GER_veg_Vmedio_nm_288.txt) con la siguiente 

estructura: 

 

 
Figura 13: GER_soil_V_MEDIO_nm.txt 
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3.4. – PROCESO DE VALIDACIÓN 

En el presente proyecto se pretende dar validez a los datos tomados por el sensor 

CASI y al proceso de corrección atmosférica, de tal manera que los datos ofrecidos por las 

imágenes captadas por el sensor CASI tengan valor de fiabilidad. 

La concordancia entre los espectros obtenidos por el sensor CASI y los obtenidos 

por el espectroradiómetro depende de la naturaleza del objeto observado y empeora al 

aumentar la proporción de suelo [3]. En el caso de un cultivo como un viñedo dado su 

carácter heterogéneo, cualquier pixel se espera que incluya suelo y vegetación. Así, hemos 

modelado los espectros obtenidos por el sensor como una combinación lineal de dos 

reflectancias procedentes de la tierra y vegetación. La relación lineal se puede escribir de 

la siguiente manera: 

𝝆 (𝑪𝑨𝑺𝑰) = 𝑺 ×  𝛒(𝐬𝐮𝐞𝐥𝐨 𝐜𝐚𝐦𝐩𝐨) + 𝐕 × 𝛒(𝐯𝐞𝐠𝐞𝐭𝐚𝐜𝐢ó𝐧 𝐜𝐚𝐦𝐩𝐨) 

Siendo:  
     𝝆 (CASI) : reflectancia medida por el sensor CASI  
     v : variable vegetación  
     𝝆v : reflectancia medida por el espectroradiómetro para la vegetación  
     s : variable suelo  
     𝝆s : reflectancia medida por el espectroradiómetro para el suelo 

Las firmas espectrales 𝝆 s y 𝝆 v no tienen que ser entendidas como firmas 

espectrales puras del suelo y puras de vegetación, sino como dos firmas espectrales 

obtenidas de mediciones terrestres que representan los dos extremos de todos los 

posibles espectros mixtos suelo-vegetación. Esto es fácilmente entendible en el caso de 𝝆 

v, ya que incluso en el caso de que la medición se tome justo encima de la cubierta 

vegetal, alguna radiación procedente del suelo será tomada por el radiómetro debido al 

campo de visión del instrumento.  

El cálculo estadístico se realiza con un 95% de confianza y con un nivel de 

significación del 5%. Con esto queremos decir que aquellos pixeles para los que el p_valor 

de v es menor de 0.05, la variable v es explicativa, lo mismo en el caso de s [8].  

Ya que es de esperar que el parámetro v proporcione información sobre el estado 

de la vid, posteriormente, se representa el NDVI de cada pixel frente al valor de v para 
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aquellos píxeles para los que v > 0 o p-valor (v) < 0.05. Se encontrará una relación lineal 

entre ambos. 

 

4.- PROCEDIMIENTO 

4.1. – GEORREFERENCIACIÓN DE IMÁGENES 

Se define georreferenciación como proceso mediante el cual se efectúa la 

alineación de una imagen respecto a un sistema de coordenadas de referencia de forma 

que cualquier punto de la misma adquiera unas coordenadas concretas. De ésta manera se 

dota de validez cartográfica a una imagen obtenida a partir de un sensor 

aerotransportado, corrigiendo geométricamente la posición de las celdas y atribuyéndoles 

coordenadas en algún sistema de referencia [1]. 

Las imágenes proporcionadas por el INTA no están georreferenciadas, pero junto 

con las imágenes se nos proporciona un fichero de geo-localización que nos permite 

realizar la misma. Dicha georreferenciación se lleva a cabo con el programa ENVI a través 

del siguiente proceso: 

Primero debemos crear un GTL, a partir de la barra de herramientas de ENVI: Map 

->Georreference from Input Geometry -> Build GTL. 

 Figura 14: Construcción GTL. 
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Se abre la ventana siguiente, donde debemos marcar la pestaña Open, y abrir el 

archivo de geolocalización correspondiente a la imágen, con la extensión .glu:  

 

 

 

Figura 14: Archivo imagen formato .glu. 

 

 

 

 

 

Figura 15: Input X Geometry Band. 
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Habiendo cargado archivo geolocalizador correspondiente de la imagen, la ventana 

anterior tiene el aspecto siguiente: 

 

Figura 16: Input X Geometry Band. 

 

Como dice el nombre de la ventana (Input X Geometry Band), debemos seleccionar 

la referencia de X (EAST) Una vez pulsado OK, aparece la ventana siguiente, donde nos 

pide la referencia de la Y, teniendo que marcar NORTHING, y posteriormente OK; 
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Figura 17: Input Y Geometry Band. 

 

A continuación se abre Geometry Projection Information, seleccionando como 

proyección UTM, zona 30 Norte, y dátum WGS84; 
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Figura 18: Geometry Projection Information. 

 

 Al dar  OK, se construye el GTL, e irrumpe una ventana para elegir el tamaño de 

pixel (dependiendo la altitud del vuelo; a 1000 metros de altura, 2 metros tamaño de píxel. 

A 1859, 1,25 metros tamaño de píxel) 
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Figura 19: Build Geometry Lookup Parameters. 

 

Damos nombre al archivo GTL y lo ubicamos para guardarlo. Ya tenemos disponible 

el archivo GTL para comenzar la georreferenciación de la foto correspondiente. 

Ahora para georreferenciar la imagen, debemos, en la barra de herramientas de 

ENVI, ir a Map-> Georreference  from Input Geometry-> Georreference from GTL: 

 

Figura 20: Georreference from GTL. 
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 Seleccionar archivo GTL para georeferenciar, dar OK: 

 

Figura 21: Input Geometry Lookup File.. 

 

 En la siguiente ventana cargar la imagen a georreferenciar, y OK: 
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Figura 22: Input Data File. 

 

  Más tarde aparece: 

 

Figura 23: Georreference from GTL Parameters. 

 

En dicha ventana, ponemos nombre a la nueva imagen ya georreferenciada y la 

guardamos. 
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4.2. – RECORTE DE IMÁGENES 

Debido a que sólo vamos a trabajar los datos correspondientes al viñedo sobre el 

que se basa el estudio, debemos crear una máscara o región de interés (ROI), que nos 

permitirá quedarnos solamente con ésa parte. Para ello, una vez que abrimos una imagen 

con el software ENVI, es posible crear la ROI (Región of Interest)  en Basic Tools-> Region 

of Interest-> ROI Tool: 

 

Figura 24: ROI Tool. 

 

Una vez hemos elegido la región de interés mediante un rectángulo, guardamos la 

imagen recortada en el menú Basic Tools -> Subset Data Via ROIs, apareciendo la siguiente 

ventana, donde debemos introducir el nombre de la imagen de salida y su ubicación. 
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Figura 25: Spatial Subset via ROI Parameters. 

 

4.3. – CREACIÓN DE LA MALLA 

A continuación creamos una malla empleando el programa Arcgis con el fin de 

poder extraer la reflectividad de cada pixel perteneciente a la zona del viñedo de estudio.  

Para abrir con ArcGis las imágenes recortadas debemos cambiar la extensión del 

fichero a .hdf. 

La malla se crea a partir de la herramienta Create Fishnet (Data Management Tools 

-> Feature Class -> Create Fishnet). En ella nos pide el tamaño del píxel de la imagen (en 

función de la altitud de vuelo) y el número de filas y columnas, que se obtiene a través de 

ENVI, teniendo una imagen abierta en visualización: File -> Edit ENVI Header. 
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Figura 26: Herramienta Create Fishnet (ArcGis). 

 

Una vez realizado el paso anterior, ArcGis crea una malla y una malla de centroides 

(ambas de tipo vectorial) en función del tamaño de píxel asignado, y cuya ubicación cubre 

toda la imagen. Puesto que sólo queremos tener la malla y malla de centroides 

correspondiente al viñedo de la zona de estudio, hacemos una selección de los registros 

correspondientes a dicha zona, mediante la herramienta de selección de entidades 

mediante un polígono. 

A continuación se muestran la malla y la malla de centroides ubicadas sobre el 

viñedo, después de haber eliminado aquellos registros que se encuentran fuera de la zona 

de estudio, para posteriormente poder obtener únicamente datos de reflectancia de ésta 

zona, obtenidos por el sensor CASI. 
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Figura 27: Malla con trasparencia, superpuesta sobre imagen CASI. 

 

 

Figura 28: Malla obtenida, con los seleccionados registros correspondientes al viñedo. 
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Figura 29: Malla de centroides obtenida, con los seleccionados registros correspondientes al 
viñedo. 

 

Una vez realizado el proceso anterior, debemos enlazar la malla creada en ArcGis 

con cada una imagen de las imágenes para poder extraer la reflectividad de cada píxel. 

Para ello se procede desde ENVI; abrimos una de las imágenes: File -> Open Image File. 

Sobre ella abrimos el vectorial de centroides: File -> Open Vector File. A continuación 

irrumpe una ventana denominada Available Vectors List –> File -> Export Layers to ROI, 

seleccionando la opción convert each record of an evf to New ROI. Una vez realizado lo 

anterior se procede seguidamente a la extracción de reflectividades. 

 

4.4. – EXTRACCIÓN DE REFLECTIVIDADES 

El proceso de extracción de reflectividades de las imágenes obtenidas por el sensor 

CASI de INTA se realiza utilizando un scrip programado en IDL, proporcionado por Juan 

José Peón García, descargado de la librería de código de IDL. El scrip se expone a 

continuación: 
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; DATE: 08/22/00 

; 

; Modified by Jonathan Greenberg 2/18/04 to use comma separation 

;   and include a header line (the band names) that other programs 

;   can read. 

; 

; OBJECTIVE: Extract data from ROIs and saves in a format 

;            compatible with other database programs. 

; 

; USAGE: Under ENVI prompt type rois_to_csv. Then press enter. 

;        and follow the steps. 

; 

; ****************************************************************** 

pro rois_to_csv 

  ;Select file name to save 

 filename=dialog_pickfile(Title='Enter File Name') 

 if filename eq '' then return 

 Openw, lun, filename, /Get_lun 

  envi_select, title='Input Filename', fid=fid, pos=pos 

  if (fid eq -1) then return 

  envi_file_query,fid,bname=bname,nb=nb 

  bname=["ROI_Name",bname] 

  printf,FORMAT='(1000(A,:,","))',lun, bname 

  ;Check ROIs associated with the image 

  roi_ids = envi_get_roi_ids(fid=fid, roi_names=roi_names,/Short_name) 

  if (roi_ids[0] eq -1) then begin 

    print, 'No regions associated with the selected file' 

    return 

  endif 

  ; Compound widget for ROI selection 

  base = widget_auto_base(title='ROI Selection') 

  wm   = widget_multi(base, list=roi_names, uvalue='list', /auto) 

  result = auto_wid_mng(base) 

  if (result.accept eq 0) then return 

  ptr = where(result.list eq 1, count) 

  ; ROI data extraction 

  for i=0l, count-1 do begin 

     ;Initialize temp_data to hold the ROI's data 

      data = envi_get_roi_data(roi_ids[ptr[i]], fid=fid, $ 

      pos=[0]) 

      temp_data = fltarr(n_elements(pos),n_elements(data)) 

      ;Extract the data for each ROI 

       for j=0l, n_elements(pos)-1 do begin 

               data = envi_get_roi_data(roi_ids[ptr[i]], fid=fid, $ 

               pos=pos[j]) 

               temp_data[j,*] = data 

               help, temp_data 

           endfor 

       ;Prints the ROI data to filename 

           for k = 0L, n_elements(temp_data[0,*])-1 do begin 

               printf, FORMAT='(A,:,",",1000(F12.4,:,","))',lun, roi_names[i], 

temp_data[*,k] 

           endfor 

       ;Returns to the next ROI 

  endfor 

   Free_lun, lun 

   print,'Done!' 

end 

 

Tras asociar la malla de centroides (vectorial) a la imagen CASI a través de ENVI, se 

debe ejecutar el scrip a través de ENVI IDL Workbench.  Tras su ejecución se obtiene un 

fichero de texto con un valor de reflectividad para cada uno de los puntos de la malla de 

centroides, que corresponde a cada píxel ubicados en el viñedo de la zona de estudio. El 

resultado se expone en la tabla siguiente, donde solo se muestran las 10 primeras bandas 



Validación de datos hiperespectrales 

 Página 44 
 

(bandID y bandLON, número del canal, y longitud de onda, respectivamente) y 20 primeros 

píxeles (P0, P1, P2…) de la imagen obtenida el día 25 a las 8:43 horas, a modo de muestra. 

bandID B001 B002 B003 B004 B005 B006 B007 B008 B009 B010 

bandLON 363,9 366,3 368,8 371,2 373,6 376 378,4 380,9 383,3 385,7 

P0 25 25 25 25 60 138 111 139 181 235 

P1 25 25 25 25 118 126 114 124 216 235 

P2 25 25 25 25 152 151 121 175 194 258 

P3 25 25 25 25 91 85 25 59 161 201 

P4 25 25 25 25 91 85 25 59 161 201 

P5 25 25 25 25 54 162 63 165 155 322 

P6 25 25 25 25 92 99 71 101 129 245 

P7 25 25 25 25 25 90 68 153 177 219 

P8 25 25 25 31 83 138 126 110 164 228 

P9 25 25 25 25 50 83 94 104 188 259 

P10 25 25 25 25 118 126 114 124 216 235 

P11 25 25 25 25 152 151 121 175 194 258 

P12 25 25 25 46 143 214 124 140 222 292 

P13 25 25 25 25 91 85 25 59 161 201 

P14 25 25 25 25 54 162 63 165 155 322 

P15 25 25 25 27 108 187 212 202 255 311 

P16 25 25 25 25 55 160 110 121 193 258 

P17 25 25 25 25 125 161 100 85 199 281 

P18 25 25 25 25 73 198 109 126 240 286 

P19 25 25 25 25 53 115 111 143 180 215 

P20 25 25 25 25 25 72 25 39 137 168 

Tabla 6: Reflectividades imagen 08:43 del 25 de Julio. 
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4.5. – CÁLCULO DE ESTADÍSTICOS 

Para el cálculo de los estadísticos v, s, r, r2, p_valor_veg, p_valor_suelo, se emplea 

un scrip de RComander, desarrollado por Juan José Peón García; 

# GER data 
GERref <- read.table("C:/Nuevacarpeta/ger.txt",header=TRUE, dec=".") 
 
 
# AHS data 
AHSref <- read.table("C:/Nuevacarpeta/casi.txt",header=FALSE, dec=".") 
AHSref <- t(AHSref) 
colnames(AHSref) <- NULL 
rownames(AHSref) <- NULL 
AHSrefcolnames <- AHSref[1,2:dim(AHSref)[2]] 
AHSrefrownames <- AHSref[2:dim(AHSref)[1],1] 
AHSref <- AHSref[-1,-1] 
AHSref <- as.data.frame(AHSref) 
colnames(AHSref) <- AHSrefcolnames 
rownames(AHSref) <- AHSrefrownames 
AHSref <- AHSref[,-1] 
AHSrefcolnames <- AHSrefcolnames[-1] 
AHSref <- as.matrix(AHSref) 
AHSref2 <- matrix(ncol=dim(AHSref)[2],nrow=dim(AHSref)[1],NA) 
for(i in 1:dim(AHSref)[2]) 
{ 
AHSref2[,i]<-as.numeric(AHSref[,i]) 
} 
AHSref <- AHSref2 
AHSref <- AHSref/10000 
colnames(AHSref) <- AHSrefcolnames 
rownames(AHSref) <- AHSrefrownames 
# LM 
LMresults <- matrix(ncol=6,nrow=dim(AHSref)[2],NA) 
for(i in 1:dim(AHSref)[2]) 
{ 
  LM <- lm(AHSref[,i]~GERref$ref_GER_mean_veg+GERref$ref_GER_mean_soil -1) 
  LMresults[i,1] <- summary(LM)$r.squared # r2 
  LMresults[i,2] <- sqrt(summary(LM)$r.squared) # r 
  LMresults[i,3] <- summary(LM)$coefficients[1,1] # a (ref_GER_mean_veg) 
  LMresults[i,4] <- summary(LM)$coefficients[2,1] # b (ref_GER_mean_soil) 
  LMresults[i,5] <- summary(LM)$coefficients[1,4] # aPr 
  LMresults[i,6] <- summary(LM)$coefficients[2,4] # bPr 
  rm(LM) 
  if(LMresults[i,3]<0){ 
    LM <- lm(AHSref[,i]~GERref$ref_GER_mean_soil -1) 
    LMresults[i,1] <- summary(LM)$r.squared # r2 
    LMresults[i,2] <- sqrt(summary(LM)$r.squared) # r 
    LMresults[i,3] <- 0 # a (ref_GER_mean_veg) 
    LMresults[i,4] <- summary(LM)$coefficients[1,1] # b (ref_GER_mean_soil) 
    LMresults[i,5] <- 0 # aPr 
    LMresults[i,6] <- summary(LM)$coefficients[1,4] # bPr 
    rm(LM) 
  } 
  if(LMresults[i,4]<0){ 
    LM <- lm(AHSref[,i]~GERref$ref_GER_mean_veg -1) 
    LMresults[i,1] <- summary(LM)$r.squared # r2 
    LMresults[i,2] <- sqrt(summary(LM)$r.squared) # r 
    LMresults[i,3] <- summary(LM)$coefficients[1,1] # a (ref_GER_mean_veg) 
    LMresults[i,4] <- 0 # b (ref_GER_mean_soil) 
    LMresults[i,5] <- summary(LM)$coefficients[1,4] # aPr 
    LMresults[i,6] <- 0 # bPr 
    rm(LM) 
  } 
} 
colnames(LMresults) <- c("r2","r","a_veg","b_soil","Pr_a_veg","Pr_b_soil") 
rownames(LMresults) <- AHSrefcolnames 
 
write.table(LMresults, "C:/Nuevacarpeta/LMresults.txt", 
  sep="\t", col.names=TRUE, row.names=TRUE, quote=TRUE, na="NA") 
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Los estadísticos que obtendremos son los siguientes: 

- v y s las variables a analizar (vegetación y suelo) 

- r (coeficiente de determinación) y r2 (coeficiente de determinación al cuadrado) , 

reflejan el grado de acuerdo entre las variables.  

- p_valor_suelo y p_valor_veg, son los valores de contraste. Indican que con un 

nivel de confianza del 95% aquellos pixeles cuyo valor de contraste este por debajo del 

0.05 (5% significación) serán explicativos de la variable que representan. Suelo (s) o 

vegetación (v)  

Los estadísticos anteriores son resultado de la comparación de los valores de 

reflectividad de cada imagen captada por el sensor CASI, con valores de la media de los 

tres plots (Plot Medio).  

Para obtener los resultados estadísticos, se debe proporcionar al programa por un 

lado los valores de Plot Medio (uno para las imágenes de 144 canales y otro para las de 

288 canales), y por otro lado los valores de reflectividades de las imágenes(un archivo por 

imagen). El archivo resultante se denominará LM_results.txt, que son los resultados 

estadísticos de cada imagen, para los valores de Plot Medio.  

A continuación se muestran en tablas 7, 8, 9, 10, 11 y 12, los datos de campo 

remuestreados para imágenes de 288 canales y para 144 canales, los datos de la imagen 

captada a las 8:43 del 25 de junio (288 canales) y los de la imagen de las 9:09 del 26 de 

junio (144 canales),  y los resultados estadísticos de ambas imágenes: 
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BandID Bandlon ref_GER_mean_soil ref_GER_mean_veg 

B1 0,3639 0,0666 0,0310 

B2 0,3663 0,0659 0,0303 

B3 0,3688 0,0656 0,0298 

B4 0,3712 0,0656 0,0294 

B5 0,3736 0,0656 0,0291 

B6 0,3760 0,0657 0,0288 

B7 0,3784 0,0661 0,0286 

B8 0,3809 0,0665 0,0284 

B9 0,3833 0,0670 0,0282 

B10 0,3857 0,0677 0,0282 

B11 0,3881 0,0682 0,0281 

B12 0,3905 0,0686 0,0278 

B13 0,3930 0,0692 0,0276 

B14 0,3954 0,0699 0,0276 

B15 0,3978 0,0709 0,0276 

B16 0,4002 0,0714 0,0276 

B17 0,4026 0,0719 0,0274 

B18 0,4050 0,0727 0,0273 

B19 0,4075 0,0739 0,0275 

B20 0,4099 0,0752 0,0278 

Tabla 7: Valores de Plot Medio remuestreados para 288 canales, exponiendo 20 primeros canales a 
modo de muestra. 

BandID Bandlon ref_GER_mean_soil ref_GER_mean_veg 

B1 0,3651 0,066289 0,030644 

B2 0,3700 0,065659 0,029625 

B3 0,3748 0,065664 0,028924 

B4 0,3796 0,066266 0,028472 

B5 0,3845 0,067342 0,028202 

B6 0,3893 0,068394 0,027945 

B7 0,3942 0,069582 0,027630 

B8 0,3990 0,071122 0,027587 

B9 0,4038 0,072378 0,027394 

B10 0,4087 0,074553 0,027687 

B11 0,4135 0,077267 0,028364 

B12 0,4183 0,080289 0,029306 

B13 0,4231 0,083191 0,030253 

B14 0,4280 0,086525 0,031425 

B15 0,4328 0,090150 0,032825 

B16 0,4376 0,093278 0,033857 

B17 0,4424 0,096448 0,034832 

B18 0,4473 0,099818 0,035853 

B19 0,4521 0,102989 0,036771 

B20 0,4569 0,106031 0,037546 
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Tabla 8: Valores de Plot Medio remuestreados para 144 canales, exponiendo 20 primeros canales a 
modo de muestra. 

Como se puede observar en las dos tablas anterior de valores de campo medio, hay 

dos campo denominados como ref_GER_mean_soil (reflectividad media del 

espectroradiómetro GER para el suelo) y otra columna llamada ref_GER_mean_veg 

(reflectividad media del espectroradiómetro GER para la vegetación). Estos datos 

corresponden a 𝝆 s y 𝝆 v de la pg. 29 de éste trabajo. 

 

 

bandID B001 B002 B003 B004 B005 B006 B007 B008 B009 B010 

bandLON 0.3639 0.3663 0.3688 0.3712 0.3736 0.376 0.3784 0.3809 0.3833 0.3857 

P1 25 25 25 25 60 138 111 139 181 235 

P2 25 25 25 25 118 126 114 124 216 235 

P3 25 25 25 25 152 151 121 175 194 258 

P4 25 25 25 25 91 85 25 59 161 201 

P5 25 25 25 25 91 85 25 59 161 201 

P6 25 25 25 25 54 162 63 165 155 322 

P7 25 25 25 25 92 99 71 101 129 245 

P8 25 25 25 25 25 90 68 153 177 219 

P9 25 25 25 31 83 138 126 110 164 228 

P10 25 25 25 25 50 83 94 104 188 259 

P11 25 25 25 25 118 126 114 124 216 235 

P12 25 25 25 25 152 151 121 175 194 258 

P13 25 25 25 46 143 214 124 140 222 292 

P14 25 25 25 25 91 85 25 59 161 201 

P15 25 25 25 25 54 162 63 165 155 322 

P16 25 25 25 27 108 187 212 202 255 311 

P17 25 25 25 25 55 160 110 121 193 258 

P18 25 25 25 25 125 161 100 85 199 281 

P19 25 25 25 25 73 198 109 126 240 286 

P20 25 25 25 25 53 115 111 143 180 215 

Tabla 9: Valores de reflectividad por para cada píxel, de la imagen a las 8:43 del 25 de julio, 
exponiendo los 10 primeros canales y 20 primeros píxeles a modo de muestra. 
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bandID B001 B002 B003 B004 B005 B006 B007 B008 B009 B010 

Bandlon 0,3651 0,3700 0,3748 0,3796 0,3845 0,3893 0,3942 0,3990 0,4038 0,4087 

P1 25 25 25 25 80 240 261 272 350 462 

P2 25 25 25 25 58 188 289 270 343 423 

P3 25 25 25 25 70 215 321 321 367 466 

P4 25 25 25 25 25 143 258 222 265 364 

P5 25 25 25 25 132 205 313 324 358 504 

P6 25 25 25 25 132 205 313 324 358 504 

P7 25 25 25 25 87 177 230 228 298 418 

P8 25 25 25 25 62 191 274 242 272 362 

P9 25 25 25 25 95 205 309 238 298 371 

P10 25 25 25 25 117 283 325 271 338 474 

P11 25 25 25 31 191 304 326 317 407 513 

P12 25 25 25 25 69 240 274 253 358 484 

P13 25 25 25 25 25 120 207 248 312 424 

P14 25 25 25 25 82 243 295 288 284 391 

P15 25 25 25 25 82 243 295 288 284 391 

P16 25 25 25 25 50 168 250 241 277 349 

P17 25 25 25 25 50 168 250 241 277 349 

P18 25 25 25 25 63 116 272 229 243 331 

P19 25 25 25 25 112 195 326 286 368 504 

P20 25 25 25 25 142 273 260 265 348 456 
 

Tabla 10: Valores de reflectividad por para cada píxel, de la imagen a las 9:09 del 26 de julio, 
exponiendo los 10 primeros canales y 20 primeros píxeles a modo de muestra. 
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IDENT r2 r a_veg b_soil Pr_a_veg Pr_b_soil 

P1 0.99518668 0.99759043 0.14345842 0.94646339 3.3006361E-14 1.3944195E-168 

P2 0.99498459 0.99748914 0.23460728 0.80344756 4.0888051E-33 5.0826301E-155 

P3 0.99482585 0.99740957 0.21445028 0.80713809 8.4844709E-29 3.0538348E-155 

P4 0.99519673 0.99759547 0.22661288 0.80922238 1.6109198E-32 2.1060056E-158 

P5 0.99519673 0.99759547 0.22661288 0.80922238 1.6109198E-32 2.1060056E-158 

P6 0.99557707 0.99778609 0.10706191 0.99615663 3.2830722E-09 2.6101302E-177 

P7 0.99508364 0.99753879 0.25922642 0.80886018 1.7088849E-37 4.9642794E-154 

P8 0.99616686 0.99808159 0.1025038 0.93770764 1.3491059E-10 1.4077118E-185 

P9 0.99571344 0.99785442 0.18843722 0.86216907 6.4785499E-26 8.3055476E-170 

P10 0.99514281 0.99756845 0.21919391 0.85784745 8.8325029E-29 1.1894550E-159 

P11 0.99498459 0.99748914 0.23460728 0.80344756 4.0888051E-33 5.0826301E-155 

P12 0.99482585 0.99740957 0.21445028 0.80713809 8.4844709E-29 3.0538348E-155 

P13 0.99479007 0.99739163 0.26260335 0.80030254 6.3589062E-37 3.6055994E-150 

P14 0.99519673 0.99759547 0.22661288 0.80922238 1.6109198E-32 2.1060056E-158 

P15 0.99557707 0.99778609 0.10706191 0.99615663 3.2830722E-09 2.6101302E-177 

P16 0.99545781 0.99772632 0 1.00918459 0 0 

P17 0.99458841 0.99729053 0.33744731 0.67212347 9.2302175E-56 4.2764804E-136 

P18 0.99535926 0.99767693 0.34751508 0.71188165 5.3556541E-60 1.4324015E-145 

P19 0.99484435 0.99741884 0.27623166 0.77018244 4.1631360E-41 1.4977316E-148 

P20 0.99606978 0.99803296 0.15810855 0.94872752 3.5965907E-19 3.6678028E-179 

Tabla 11: Resultados estadísticos para el Plot Medio, de la imagen captada a las 8:43 horas del días 25 
de julio, exponiendo los 10 primeros canales y 20 primeros píxeles a modo de muestra. 
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IDENT r2 r a_veg b_soil Pr_a_veg Pr_b_soil 

P1 0.9953883 0.9976915 0.1835041 0.9807575 1.42656E-10 2.53626E-84 

P2 0.9947051 0.9973490 0.3397153 0.8365695 1.17702E-23 3.33736E-72 

P3 0.9942858 0.9971388 0.1646803 0.9682082 6.14078E-08 7.19052E-79 

P4 0.9947727 0.9973829 0.1664232 1.0151161 4.35999E-08 1.14897E-81 

P5 0.9964347 0.9982158 0.1017706 1.0556938 2.73393E-05 1.07747E-95 

P6 0.9964347 0.9982158 0.1017706 1.0556938 2.73393E-05 1.07747E-95 

P7 0.9942381 0.9971149 0.3928553 0.7280413 3.55496E-29 1.58008E-65 

P8 0.9932730 0.9966308 0.4774322 0.6050137 1.03435E-35 1.95445E-54 

P9 0.9934047 0.9966969 0.4013559 0.7669401 4.85195E-26 2.14799E-62 

P10 0.9945363 0.9972644 0.1996387 0.9432739 6.60565E-11 1.76586E-78 

P11 0.9959407 0.9979683 0.0734792 1.0376691 2.79231E-03 5.09626E-93 

P12 0.9961102 0.9980532 0.0735256 1.1092905 4.07182E-03 1.77416E-94 

P13 0.9954588 0.9977268 0.1505514 1.0295495 1.00765E-07 1.83647E-86 

P14 0.9957485 0.9978720 0.3517048 0.7656187 1.29039E-30 1.52005E-76 

P15 0.9957485 0.9978720 0.3517048 0.7656187 1.29039E-30 1.52005E-76 

P16 0.9925407 0.9962634 0.4077177 0.7239941 1.17691E-25 0 

P17 0.9925407 0.9962634 0.4077177 0.7239941 1.17691E-25 5.98138E-58 

P18 0.9938250 0.9969077 0.4766607 0.6365180 3.54823E-36 1.09919E-57 

P19 0.9958003 0.9978979 0.0784861 1.0759907 2.51453E-03 6.31587E-92 

P20 0.9956673 0.9978313 0.1141865 1.0489522 2.12548E-05 1.98270E-89 

Tabla 11: Resultados estadísticos para el Plot Medio, de la imagen captada a las 9:09 horas del días 26 
de julio, exponiendo los 10 primeros canales y 20 primeros píxeles a modo de muestra 

 
 

4.6. – ELABORACIÓN DE MAPAS 

Para conseguir una mayor comprensión de los datos obtenidos se elaboraron una 

serie de mapas donde se puede observar cómo varían los estadísticos a lo largo de la 

superficie del viñedo, y así comprobar si las tres muestras tomadas en campo son 

representativas del total, a través de los valores de Plot Medio. 

La elaboración de los mapas se ha llevado a cabo a través del software ArcGis, para 

lo cual fue necesario importar las tablas Excel con los datos estadísticos, y asociar dichos 

estadísticos a la malla previamente creada, a través de una unión de tablas. 

Disponemos de un total de 10 imágenes (5 del día 25/07 y 5 del 26/07), y hemos 

obtenido un total de 6 estadísticos para cada imagen, a partir de la comparación de los 
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datos CASI con los datos de Plot Medio (media de los tres plots). Al final el resultado es un 

total de 60 mapas (seis por imagen) 

Además se han elaborado un mapa con el índice de vegetación (NDVI) para cada 

imagen, con el fin de tener una comparación de los píxeles que son considerados 

estadísticamente como hoja de viñedo y de ésta manera asegurarnos de la fiabilidad de los 

cálculos obtenidos. 

 

5.- RESULTADOS 

A continuación se muestran los mapas del vuelo de las 08:43 horas, del 25 de julio 

de 2012, y para el vuelo de las 9:09  horas del 26 de julio de 2012. Se han elegido éstas dos 

imágenes por ser imágenes obtenidas en vuelos a diferente hora, diferente día y distinta 

resolución espacial (2m. y 1,25 m. respectivamente). Los mapas para el resto de imágenes 

y estadísticos están disponibles en el Anexo I de éste trabajo. 

Como se puede observar más abajo, los valores de r como de r2 son muy elevados 

en cada una de las imágenes, para el Plot Medio lo que nos da la idea de una alta 

correlación de los datos entre los obtenidos en campo (espectroradiómetro GER) y los 

obtenidos por el sensor CASI. El estadístico V es bastante elevado en todo el viñedo, con la 

excepción de dos hileras correspondientes con dos caminos donde hay suelo desnudo. Si 

se observa el valor S, se ve que aumenta mucho en dichas zonas de suelo desnudo, 

aunque también es visible dicho aumento en otras zonas, debido al carácter heterogéneo 

de un cultivo como es un viñedo. 

En cuanto a los valores de p para vegetación y para suelo, se observa que con un 

95% de confianza y con un nivel de significación del 5%, la variable V es explicativa de la 

vegetación en prácticamente todo el viñedo y en las zona donde se sitúa el camino (suelo 

desnudo), y la variable S es explicativa para todos los píxeles del viñedo. 

 

(¡!!
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En los mapas siguientes se muestran la representación del valor NDVI para las 

imágenes del 25 de julio de 2012 a las 08:43 y el del 26 de julio de 2012 a las 09:09 horas). 

Observando dichos mapas se puede apreciar que las zonas de camino son aquellas de 

color rojo, donde los valores de NDVI son los más bajos, indicando un índice de vegetación 

bajo. En comparación, los píxeles de color verde poseen un valor de NDVI más elevado, lo 

que indica que dichos píxeles poseen en su mayor parte vegetación. Por otra parte los 

píxeles de color amarillento tienen un valor de NDVI intermedio, lo que indica que en 

dichos píxeles existe una mezcla de vegetación y suelo desnudo. Los mapas de ambas 

imágenes se exponen a continuación: 

 



Validación de datos hiperespectrales 

 Página 13 
 

 

 



Validación de datos hiperespectrales 

 Página 14 
 

 



Validación de datos hiperespectrales 

 Página 15 
 

También se han elaborado gráficos de dispersión donde se representa el índice de 

vegetación (respecto al Plot Medio) frente al valor de V. El objetivo es analizar como varía 

la variable NDVI en función de la variable V. Se trata entonces de un problema de 

regresión en el que se obtiene una fórmula que permite describir la relación entre las dos 

variables. El diagrama de dispersión permite detectar visualmente si existe relación entre 

las dos variables y el coeficiente de determinación r2 permite cuantificar la bondad del 

ajuste [9]. En éste caso, se observa una relación muy clara ya que los puntos se aproximan 

bastante a las rectas de regresión. 

Por último, para cada uno de los archivos correspondientes a los resultados 

estadísticos obtenidos para las imágenes, se realizó a través de ArcGis una selección por 

atributos de diferentes consultas muy útiles para dar validez a los datos; 

- Píxeles para los cuales V es mayor que 0 (los píxeles donde el valor es 0, la variable 

V no está definida), y p_valor_veg sea menor que 0,05. La expresión a introducir es 

la siguiente: 

"a_veg" > 0 AND "Pr_a_veg" <0.05   (siendo “a_veg” valor V) 

- Píxeles para los que V es mayor que 0 (píxeles donde V es igual a 0, la variable V no 

está definida), y p_valor_veg sea mayor que 0.05. La expresión es la siguiente: 

"a_veg" > 0 AND "Pr_a_veg" >0.05   (siendo “a_veg” valor V) 

- Los pixeles para los cuáles V es igual a 0; 

"a_veg" = 0   (siendo “a_veg” valor V) 

- Los píxeles para los que S es mayor que 0 y p_valor_suelo sea menor que 0.05. La 

expresión es la siguiente: 

"b_soil" > 0 AND "Pr_b_soil" <0.05   (siendo “b_soil” valor S) 

Los datos obtenidos en éstas consultas de atributos, se expresan a continuación,  

junto a los gráficos de regresión de NDVI frente V, en forma de tabla denominada 

“distribución de píxeles”.  
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Vuelo de las 08:43 del 25 de julio de 2012 

 

 

 

 

 

 

 

 

DISTRIBUCIÓN DE PÍXELES 
8:43 Número de píxeles Porcentaje 

v > 0 y p_valor_veg<0.05 5300 96.066 

v > 0 y p_valor_veg > 0.05 77 1.395 

v = 0 140 2.537 

s > 0 y p_valor_suelo < 0.05 5517 100 
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Vuelo de las 08:51 del 25 de julio de 2012 

 

 

 

 

DISTRIBUCIÓN DE PÍXELES 
8:51 Número de píxeles Porcentaje 

v > 0 y p_valor_veg<0.05 5055 92.514 

v > 0 y p_valor_veg > 0.05 174 3.184 

v = 0 235 4.3 

s > 0 y p_valor_suelo < 0.05 5451 99.762 
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Vuelo de las 09:02 del 25 de julio de 2012 

 

 

 

 

 

DISTRIBUCIÓN DE PÍXELES 
9:02 Número de píxeles Porcentaje 

v > 0 y p_valor_veg<0.05 13895 94.018 

v > 0 y p_valor_veg > 0.05 528 3.572 

v = 0 356 2.408 

s > 0 y p_valor_suelo < 0.05 14774 99.966 
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Vuelo de las 09:11 del 25 de julio de 2012 

 

 

 

 

DISTRIBUCIÓN DE PÍXELES 
9:11 Número de píxeles Porcentaje 

v > 0 y p_valor_veg<0.05 14200 96.559 

v > 0 y p_valor_veg > 0.05 306 2.08 

v = 0 200 1.359 

s > 0 y p_valor_suelo < 0.05 14705 99.993 
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Vuelo de las 09:46 del 25 de julio de 2012 

 

 

 

DISTRIBUCIÓN DE PÍXELES 
9:46 Número de píxeles Porcentaje 

v > 0 y p_valor_veg<0.05 13980 96.513 

v > 0 y p_valor_veg > 0.05 276 1.905 

v = 0 229 1.58 

s > 0 y p_valor_suelo < 0.05 14480 99.965 

 

 

 

 



Validación de datos hiperespectrales 

 Página 21 
 

 

Vuelo de las 08:44 del 26 de julio de 2012 

 

 

 

 

DISTRIBUCIÓN DE PÍXELES 

8:44 Número de píxeles Porcentaje 

v > 0 y p_valor_veg<0.05 5492 96,148 % 

v > 0 y p_valor_veg > 0.05 100 1,75 % 

v = 0 120 2,1 % 

s > 0 y p_valor_suelo < 0.05 5711 99,982 % 
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Vuelo de las 08:53 del 26 de julio de 2012 

 

 

 

DISTRIBUCIÓN DE PÍXELES 
8:53 Número de píxeles Porcentaje 

v > 0 y p_valor_veg<0.05 5525 95.1765 

v > 0 y p_valor_veg > 0.05 137 2.36 

v = 0 143 2.463 

s > 0 y p_valor_suelo < 0.05 5777 99.517 
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Vuelo de las 09:09 del 26 de julio de 2012 

 

 

 

 

DISTRIBUCIÓN DE PÍXELES 
9:09 Número de píxeles Porcentaje 

v > 0 y p_valor_veg<0.05 13840 94.957 

v > 0 y p_valor_veg > 0.05 466 3.197 

v = 0 269 1.845 

s > 0 y p_valor_suelo < 0.05 14568 99.951 
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Vuelo de las 09:19 del 26 de julio de 2012 

 

 

 

 

DISTRIBUCIÓN DE PÍXELES 
9:19 Número de píxeles Porcentaje 

v > 0 y p_valor_veg<0.05 14743 97.242 

v > 0 y p_valor_veg > 0.05 266 1.754 

v = 0 152 1.0025 

s > 0 y p_valor_suelo < 0.05 15157 99.973 
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Vuelo de las 09:40 del 26 de julio de 2012 

 

 

 

 

DISTRIBUCIÓN DE PÍXELES 
9:40 Número de píxeles Porcentaje 

v > 0 y p_valor_veg<0.05 14094 93.766 

v > 0 y p_valor_veg > 0.05 479 3.186 

v = 0 458 3.047 

s > 0 y p_valor_suelo < 0.05 14968 99.58 
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6- CONCLUSIONES: 

Observando los gráficos de dispersión de las 10 imágenes con las que se ha 

trabajado en este proyecto se aprecia la alta correlación existente entre v y el índice de 

vegetación (NDVI) ya que r2 tiene un valor superior al 0.9 en todos los casos.  

En la Tabla 12 expuesta a continuación se representa la distribución de los pixeles 

para todas las imágenes en forma de porcentaje, donde se puede observar que S es 

explicativa para todos los pixeles del viñedo en la imagen de las 8:43 del 25 de julio, y para 

casi todos los píxeles del resto de imágenes, siendo dicho valor superior a 99,5% en dichas 

imágenes restantes. La media de dicho valor para todas las imágenes es de 99,87%. 

La variable V lo es para la mayor parte, siendo la media para todas las imágenes de 

un 95,29%. Los pixeles para los que el valor de V no está definido es bastante bajo (v = 0- >  

2,25% de media ) y lo mismo ocurre para los que V no es explicativa, es decir el 

p_valor_veg tiene un valor superior 0.05, donde la media de dicho valor para todas las 

imágenes es de 2,44%. 

Estudiando los datos de todas las imágenes podemos concluir que los datos 

tomados por el sensor CASI del INTA son completamente válidos, independientemente de 

la resolución espacial de la imagen, para la discriminación entre las distintas cubiertas 

suelo y vegetación. Ya que el porcentaje de pixeles para los que V es explicativa supera el 

92,5% en todas las imágenes y S lo es para más del 99,5% de ellas. 
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Tabla 12: Distribución de píxeles para todas las imágenes. 

 

 

 

 

 

 

 

 

DISTRIBUCIÓN DE PÍXELES EN PORCENTAJES 

Imagen v > 0 y p_valor_veg<0.05 v > 0 y p_valor_veg > 0.05 v = 0 s > 0 y p_valor_suelo < 0.05 

25/07/12, 08:43 96.066 1.395 2.537 100 

25/07/12, 08_51 92.514 3.184 4.3 99.762 

25/07/12, 09:02 94.018 3.572 2.408 99.966 

25/07/12, 09:11  96.559 2.08 1.359 99.993 

25/07/12, 09:46 96.513 1.905 1.58 99.965 

26/07/12, 08:44 96.148 1.75 2.1 99.982 

26/07/12, 08:53 95.1765 2.36 2.463 99.517 

26/07/12, 09:09 94.957 3.197 1.845 99.951 

26/07/12, 09:19 97.242 1.754 1.0025 99.973 

26/07/12, 09:40 93.766 3.186 3.047 99.58 

MEDIA 95.2959 2.4383 2.26415 99.8689 
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Anexo I 
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